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About This Manual Read this User Guide to learn how to install and use the 
Printing Tools software and fonts.

• Chapter 1 explains how to install the Printing Tools software 
and DTC fonts.

• Chapter 2 shows you how to use the Image Utility.

• Chapter 3 shows you how to use the Downloader Utility.

Refer to Appendix A for troubleshooting information and how to 
contact technical support.
About This Manual iii



Conventions This manual uses the following informational conventions:

Note A special technique or information that may help 
you perform a task or understand a process.

Caution Alerts you to something that has the potential to 
cause damage to hardware, software, or data.
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Chapter 1

Getting Started
This chapter explains how to install the Printing Tools software and DTC 
Fonts on your Macintosh.
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Introduction The Printing Tools are a collection of printer description files, 
applications, and fonts.

• The Image Utility for OS X — enables you to transfer 
(download) files in various formats directly to the print server, 
or save them to PostScript format files for downloading later. 
This utility also enables you to apply transformation options 
(such as scaling, rotation, mirroring) prior to downloading.

• Printer Description Files — describe printers to the Apple 
LaserWriter driver (supplied with your operating system).

• Digital Typeface Corporation (DTC) MasterWorks fonts 
— a collection of PostScript Type 1 compatible fonts. These 
fonts are factory-installed on the RIP, but you must also 
install a font on your computer to use and display it on your 
computer’s monitor.
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System 
Requirements

We recommend that you use a system with the following mini-
mum capabilities for the fastest print times and best output 
results:

• Macintosh — a Power PC processor with at least 24 mega-
bytes of RAM and Ethernet network adapter.

• Operating System — The Image Utility requires OS X 10.2 
(“Jaguar”) or later.

• Drivers — the PostScript Printer Description (PPD) files 
supplied will work with the OS X Print Center. Use the most 
recent version of the LaserWriter 8 driver that is compatible 
with your operating system version.

• Hard Disk — the Apple LaserWriter 8 driver spools (copies) 
files to your startup hard disk and then sends them to the 
printer. High resolution or large format print jobs require 
many megabytes of disk space to spool. The amount of free 
space required depends on the size and resolution of the 
files you print and the applications you use. 
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Installing the 
Printing Tools

1. Load the Software DVD-ROM into the DVD drive of the com-
puter.

2. Open the Printing Tools folder on the DVD-ROM.

3. Refer to the “readme” file for your operating system version 
for installation instructions.
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Uninstalling the 
Printing Tools

To uninstall the Printing Tools, drag the components into the 
Trash.
Uninstalling the Printing Tools 1-5



Installing DTC Fonts The RIP includes a set of PostScript-compatible printer fonts fac-
tory-installed on its hard disk. 

• The standard 35 fonts found on most PostScript-compatible 
printers

• DTC MasterWorks Type Library

The Digital Typeface Corporation (DTC) MasterWorks fonts are 
shipped with the Printing Tools on the software DVD-ROM disc. 
A specimen sheet showing each of the fonts is shown on the fol-
lowing pages.

Installing the fonts on your computer is necessary to display and 
make them available in the applications you use to create 
documents. You can install all or any number of individual fonts 
on your computer. It is not necessary to install the standard 35 
fonts on your computer. They are included as a standard feature 
of your operating system’s PostScript printer driver.

To use these fonts, install them on your Macintosh from the DTC 
font disks with a third-party font installer. (Alternatively, you can 
install them with the DTC Font Installer located on the disc.) The 
recommended location to install the fonts is 

/Users/your_account_folder/library/fonts

where “your_account_folder” is the user account name.

The Macintosh OS can display a maximum of 128 suitcases at a 
time. Use a font management utility to group related fonts 
together, rather than installing them individually.
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DTC MasterWorks Volume 1 fonts
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DTC MasterWorks Volume 3 fonts
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Chapter 2

Image Utility
This chapter shows you how to use the  Image Utility. The Image Utility 
enables you to download files to the print server, save image files as 
PostScript language files, and apply image transformations prior to send-
ing them to the print server.
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What is the Image 
Utility?

The  Image Utility enables you to perform the following opera-
tions on TIFF, JPEG, Encapsulated PostScript (EPS), PostScript 
(PS), and Adobe Acrobat Portable Document Format (PDF) 
files:

• Download supported file types directly to the print server

• Save the file to a PostScript language file, for subsequent 
transfer to the print server (not applicable to PS files)

• Optionally apply cropping, tiling, and scaling transformations 
to the file before sending to the print server (not supported 
for PS and PDF file types)

System Requirements The Image Utility runs under Macintosh OS X 10.2 (“Jaguar”) 
and later. For downloading and save-to-PostScript functionality 
under earlier versions of Macintosh OS, use the Downloader 
Utility (see Chapter 3).
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Configuring the 
Image Utility

1. Run the Image Utility.

Double-click the  Image Utility alias.

The Image Utility window appears.

2. To set the preferences, select Preferences from the File 
menu.

The Preferences dialog box appears. Click the tab corre-
sponding to the preferences you want to change. When you 
change a setting, it is applied immediately.
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3. Specify an output option.

• Directly to print server — The image utility sends print 
files to the printer shown (AppleTalk or TCP/IP). You can 
change the AppleTalk Zone and printer. Click the Refresh 
button to refresh the lists of zones and printers.

• Save to a PostScript file on disk — a PostScript or 
PDF file can be saved to disk, and transferred subse-
quently to the RIP via a hot folder.

• Click the Change button to change the destination. To 
reset the output file location to the default location, click 
the Reset button.

4. Specify the default measurement units for the scaling 
feature.

Select pixels, inches, or millimeters to display by default 
when scaling an image.

5. Specify the other options.

• Display TIFF/JPEG previews — specify whether to dis-
play TIFF and JPEG preview images in the transforma-
tion dialog boxes. If you do not want to wait for large 
images to display, uncheck the “Display TIFF/JPEG pre-
views” checkbox. If previews are enabled and you 
attempt to open an image that is very large, a warning will 
be displayed that allows you to proceed anyway or can-
cel (see page 2-6).

• Use passthrough mode — passes files through directly 
to file output, without any processing.

• Strip EXIF tags automatically — image files containing 
EXIF (Exchangeable Image File) data, which is descrip-
tive data added by digital cameras, can cause the RIP to 
generate PostScript errors. When you check this box, a 
duplicate of the image with the EXIF data removed from it 
is sent to the print server. The original is left unchanged. 
If downloaded images taken by digital cameras are gen-
erating PostScript errors, check this box and try down-
loading again.
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6. Click the Logging tab to specify logging options.

The Logging tab appears.

The software can keep a record, or log, of its activity. This is 
useful for troubleshooting (to determine the cause of a prob-
lem or error).

• Log activity to a file — check this box to enable logging.

• Detailed logging — check this box to increase the detail 
included in the log file, uncheck to decrease.

• To change the output file location shown, click the 
Change button.

• To reset the output file location to the default location, 
click the Reset button.
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7. Click the Warnings tab to specify Warning options.

The Warnings tab appears. Warnings alert you to potential 
problems, and give you the option of cancelling or continuing 
anyway. Check each box to enable the warning, uncheck the 
box to disable it.

• Warn about presence of EXIF tags — image files contain-
ing EXIF (Exchangeable Image File) data, which is 
descriptive data added by digital cameras, can cause the 
RIP to generate PostScript errors. See also “Strip EXIF 
tags automatically“ page 2-4.

• Warn about large images — if previews are enabled (see 
page 2-4) and you attempt to open a large image, a 
warning will be displayed that allows you to proceed any-
way or cancel. Large images may take a long time to dis-
play. You can define the threshold for what is considered 
“large” by selecting a value from the Threshold drop-
down menu.

• Warn about QuickTime installation — the Image Utility 
uses Apple QuickTime to generate certain image pre-
views, and will warn you if it is not installed.

• Warn about progressive JPEG files — some JPEG files 
are saved in a progressive format for the World Wide 
Web browsers that displays the image in a progressively 
higher quality as the image is downloaded. This has no 
application when printing, and it can cause PostScript 
errors.

8. Click the Close button to save your changes.
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Using the Image Utility 1. Run the Image Utility.

Double-click the Image Utility alias.

The Image Utility window appears.

2. Open the folder containing a supported file type.

3. Drag the file icon to the Image Utility window.

• If the file is a bitmap image (TIFF, JPEG, EPS), the trans-
formations dialog box appears with a preview of the 
image. Go to step 4.

• If the file is a PostScript (PS) or Adobe Acrobat Portable 
Document Format (PDF) file, the software displays a dia-
log box that asks whether you want to save the file to the 
destination shown on the Preferences > General tab. 
Click Save or Cancel.

4. Optionally, crop the image.

• Using the mouse, click and drag the corner handles of 
the red cropping box as desired.

• To return the cropping box to its original size and shape, 
click the Reset button.
Configuring the Image Utility 2-7



The pixel dimensions, resolution, and format of the original 
image are shown for your reference.

5. Optionally, flip, rotate, or scale the image.

Click the Transformation tab.

• Flip — check the Horizontal checkbox to create a right-
to-left mirror image, check Vertical to create a top-down 
mirror image.

• Rotate — click 90, 180, or 270 to rotate the image coun-
terclockwise by the corresponding number of degrees.

• Scaling — drag the slider or enter a scaling percentage, 
or enter the desired width or height. The aspect ratio of 
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the image is automatically preserved. The resolution of 
the printed image is updated as you change the scaling.

6. Click Save or Cancel.

• To save your changes and output the file to the print 
server or disk, click Save. The PostScript file will be out-
put according to the settings on the File - General Prefer-
ences tab.

• To cancel your changes, click Cancel. The file is not out-
put.

If you save the file to disk, use DiskDirect to print the file. 
Refer to the System Control User Guide for instructions.
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Batch Processing Batch processing allows you process a group of TIFF or JPEG 
all at once with a set of parameters that you define once. For 
example, you could download a batch of images, then arrange 
them on the server as a MediaSaver or N-UP job (refer to the 
System Control User Guide for instructions).

When you drag multiple image files onto the regular Image Utility 
window (instead of the Batch Processing window), the Cropping 
and Transformation dialog box appears for each image. To auto-
matically apply the same settings to an entire group of images, 
use Batch Processing.

1. Select an output option.

See page 2-4 for instructions. The selected option will be shown 
at the bottom of the Batch Processing window.

2. Open the Batch Processing window.

From the Window menu, select Batch TIFF/JPEG. The Batch 
Processing window appears.

3. Set the Print Mode.

• Best Fit — the image will be proportionately scaled to fit 
as closely as possible within the page size.
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• Fit Horizontal — the horizontal dimension of the image 
will be scaled to fit the horizontal dimension of the page 
size. The vertical dimension will not be scaled.

• Fit Vertical — the vertical dimension of the image will be 
scaled to fit the vertical dimension of the page size. The 
horizontal dimension will not be scaled.

• Stretch to Fit — to image will be scaled to fit as closely 
as possible within the page size, without necessarily pre-
serving the aspect ratio of the image.

4. Set the Page Size.

Select a page size from the drop-down list, or click the Set 
button to specify a page size.

5. Optionally, select Snap page size options.

When you check the Snap page size to fit image check-
box, the page size is set to the same size as the image. The 
following options are available:

• Respecting image resolution — the image is down-
loaded at the resolution found in the image file.

• At 72 dpi PostScript resolution — the image is down-
loaded at 72 dpi.

• At a fixed resolution — the image is scaled (enlarged or 
reduced) then downloaded so it prints at the resolution 
you specify.

• At a fixed scale factor — the image is scaled by the 
scaling percentage you specify, at the resolution found in 
the image file, then downloaded.

6. Set the Flip options.

The image can be flipped or mirrored horizontally or verti-
cally.

7. Set the Rotate options.

The image can be rotated in 90 degree increments.

8. Optionally, select Confirm Images Individually.
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If you enable this option, as each image is opened, a dialog 
box appears with the file name. You must confirm or cancel 
the selection of each file before downloading will proceed.

9. Drag a group of files to the Batch Processing window.

The files are processed according to the Batch Processing 
settings, then sent to the printer. You can cancel the batch 
process at any time by clicking the image in the upper por-
tion of the dialog box.
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Chapter 3

Downloader Utility
This chapter shows you how to use the Downloader Utility to download 
files and fonts to the RIP. It includes the following topics:

• About the Downloader Utility (page 3-2)

• Preferences (page 3-3)

• Using Transformation Options (page 3-9)

• Downloading PostScript Files (page 3-11)

• Downloading TIFF Files (page 3-12)

• Downloading Photo CD Files (page 3-14)
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About the 
Downloader Utility

Use the Downloader Utility to download the following 
types of files:

• EPS files to be printed

• TIFF files to be printed

• JPEG files to be printed

• PostScript files to be printed

• Kodak Photo CD files to be printed

• PostScript Type 1 and TrueType fonts to be saved on the 
RIP.

Downloading files saves you the time of importing the file into an 
application and then printing it. Downloading also prints the file 
faster than an application could by avoiding the processing over-
head of the PostScript language.

Downloading fonts saves time because the server does not 
need to wait for the fonts to be downloaded with every print job. 
You can download printer fonts only, not screen fonts or font suit-
cases.

The Downloader Utility runs in the background. This allows you 
to continue working on your Macintosh while files are being 
downloaded. You can even select a different output device in the 
Chooser and download other files using the Downloader Utility 
while continuing to download the first set of files.
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Preferences To configure the Downloader Utility preferences, select Prefer-
ences… from the Edit menu. The Preferences dialog box 
appars.

• Background Speed— Sets the amount of CPU time that is 
allocated to the Downloader Utility.

Fastest downloads files (in the background) as fast as possi-
ble. This may affect the performance of other applications 
running in the foreground. Some games, screen savers and 
applications (that place a non-movable dialog box on the 
screen for more than two minutes at a time) will not yield 
CPU time to background applications. This can cause the 
Downloader Utility to lose its connection to the RIP. Setting 
this Preference to Fastest may help, but not in all cases.

Normal (the default) makes the Downloader Utility share 
CPU time about the same as most other common Macin-
tosh applications. This is the recommended setting.

Nicest allows other applications (running in the foreground) 
as much CPU time as they request. Files are spooled more 
slowly with this setting. However, some applications may 
never yield any CPU time to the Downloader Utility. In that 
case, the Downloader Utility will timeout and drop its connec-
tion to the printer. If you have an Error Log turned on, this 
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information will be written to that log so you know what hap-
pened.

• Default Units — Sets the measuring system used for scal-
ing Photo CD and TIFF images.

• When an error needs to be reported — Sets the way in 
which you are notified of printing errors.

• Server Type — Select the server type.

• Print Engine — Select the desired output device.

• Paper — Select any page size from the popup menu.

• TIFF Download Format — Determines how TIFFs are 
downloaded to the server.

• Client-side — compatible with all versions of the RIP, it 
“wraps” the TIFF image file in PostScript code that 
enables the RIP to RIP the image, and to manipulate it in 
the manual cropping, scaling, and tiling feature of the 
System Control software.

• Server-side — compatible with versions 8.4 and later of 
the RIP, it downloads the TIFF image file as-is, which per-
mits RIPing only without modification.

• TrueType Download Format — Determines the format for 
downloading TrueType fonts; select the option that corre-
sponds to the server you are using:

• Server below v. 8.90 (Level 2 PS)

• Server v. 8.90 or above (Level 3PS)

• Error Log File — Creates an Error Log where printing error 
messages are written. This is a standard text file that can be 
opened with any text editor. When you click the Set button, a 
standard Save File dialog box appears. Select a location on 
your hard disk to log the errors, accept the default name or 
rename it. To turn the Error Log off, click the button and 
select Cancel.
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• Printer Message Log — Creates a Message Log where sta-
tus messages from the printer are written. This is a standard 
text file that can be opened with any text editor. When you 
click the Set button, a standard Save File dialog box 
appears. Select a location on your hard disk to log the 
errors, accept the name of PS Output or name it something 
else. To turn the Message Log off, click the button and select 
Cancel.
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Downloading Files There are two ways to download files with the Downloader 
Utility:

• Select files from the File menu

• Drag-and-drop files on top of the application’s icon

Note In OS X, the Downloader Utility may not run properly 
unless you restart your Macintosh in OS 9 or earlier, 
instead of launching it within OS X.

Select from the File Menu 1. Launch the Downloader Utility by double-clicking its icon.

The status dialog appears.

2. Select Download from the File menu.

The following dialog box appears:

Navigate through the disk containing the files you want to 
download.

3. Select the file you want to download.

4. Click Open.

5. Select the print options (different for each file type).

After you accept the options settings (if any), the Down-
loader Utility downloads the file to the RIP. You can view the 
progress on the status box that appears.
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Downloaded TIFF and JPEG files appear in server queues 
with the generic file names “TIFF” and “JPEG.”

Drag-and-Drop The easiest way to download a group of files is to drag and drop 
them onto the Downloader Utility icon or dialog box.

The Downloader Utility automatically launches and presents you 
with a dialog box for setting print options. As the Downloader 
Utility sends the files to the RIP, you can view the progress on 
the status box that appears.

If the drag-and-drop method results in an error, try the method 
shown on the previous page.
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Preview When you download a file, a dialog box appears that enables 
you to accept or cancel the file, or each file of a multiple-file 
batch. If the file was saved with a Macintosh preview, the pre-
view is displayed. If not, a “preview not available” message is 
displayed instead. 
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Using 
Transformation 
Options

You can print Encapsulated PostScript (EPS), Tagged Image 
Format File (TIFF), and Joint Photographic Experts Group 
(JPEG) files directly by downloading them from your workstation 
using the Downloader Utility, or from the server using the 
DiskDirect port.

You can apply a transformation mode to these files automatically 
or manually at the RIP’s Port Configuration dialog box. If you 
select automatic mode, the transformation is applied automati-
cally before printing. If you select manual mode, the job is sent to 
the Attention Queue, where you can set the mode interactively 
and then send the job to be printed.

The following modes are available:

Original / 
Printed Mode

Best Fit - scales the image to fit as much of the 
selected media size as possible. The image is 
automatically rotated if necessary for the best 
fit.

Horizontal Fit - scales the image to fit the width 
of the selected media size. Any image area 
scaled beyond the vertical dimension of the 
media size is clipped.
Vertical Fit - scales the image to fit the height of 
the selected media size. Any image area scaled 
beyond the horizontal dimension of the media 
size is clipped.

Stretch Fit - scales the image in the horizontal 
and vertical dimensions to fit the entire area of 
the selected media size, without regard to 
aspect ratio.

No Change - prints the image at its original size 
and orientation, without regard to the default 
media size selected.

Manual - allows you to interactively crop, tile, 
scale, flip, and rotate the file before it reaches 
the RIP.
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All modes except Stretch Fit preserve the original aspect ratio of 
the image. You can see how the image will look before printing 
by checking its Preview in the System Control Output queue.
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Downloading 
PostScript Files

The Downloader Utility can send PostScript files to be printed.

When you download a PostScript file, the following dialog box 
appears:

1. Select the settings for the PostScript file.

• Copies — Type in the number of copies you want to print. 
(If the number of copies specified in the file is different 
from what you specify, the number in the file will be 
used.)

• Print Engine — Specify the engine to which the file will 
be printed.

• All files — Uses these settings for all selected files.

2. Click Options to set options for the chosen output device.

See the chapter that describes the output device for informa-
tion on the available options.

3. Click OK to send the file to the RIP.
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Downloading 
TIFF Files

When you download a “Client-Side” TIFF file, the following dia-
log box appears.

1. Select the output image settings.

• Printer — Specify the engine to which the file will be 
printed.

• Output Size — With Constrain Aspect Ratio selected, you 
can type in one dimension and the other dimension will 
change proportionally. Uncheck Constrain Aspect Ratio 
to change the height and width independently. Enter the 
size in inches, centimeters, percent, or Full Page to fit to 
the paper size selected.

• Copies — Type in the number of copies you want to print.

• Print Negative — Check this box to print the file as a neg-
ative (inverse) image.

• Conserve Paper — Only the length of paper needed for 
the print will be fed from the media roll instead of the 
entire length for a standard paper size. When this option 
is selected, Paper Size, Position, and Rotation are 
grayed out. This option is unavailable when no Printer is 
specified (“Printer Default” is selected), and for color copi-
ers.

• Paper Size — Select the paper size that will fit your out-
put image area. (Grayed out if Conserve Paper is 
checked.)
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• Position — Select the position on the page where you 
want the image printed. (Grayed out if Conserve Paper is 
checked.)

• Rotation — Type in the degree of rotation; select whether 
you want the image rotated clockwise (CW) or counter-
clockwise (CCW). (Grayed out if Conserve Paper is 
checked.)

2. Click Options to set options for the chosen output device.

See the chapter in this manual that describes the output 
device for information on the available options.

3. Click Print to send the file to the RIP.

Supported TIFF Types The RIP can print downloaded TIFF files in uncompresssed for-
mat, LZW compressed format, in bitmap (1-bit), gray scale, 
RGB, or CMYK format. The server only prints the first image in a 
multi-image TIFF.
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Downloading 
Photo CD Files

The Downloader Utility can send Kodak Photo CD files directly 
to the RIP.

Note To access Photo CD files, you must have the proper 
drivers provided by the manufacturer of your CD-
ROM drive. Refer to the documentation that accom-
panies your CD-ROM drive for detailed information.

When you download a Photo CD file, this dialog box 
appears.

1. Select the output image settings for the Photo CD file.

• Resolution — Photo CD files generally come in several 
different resolutions on the same CD. The appropriate 
resolution for the selected paper size is automatically 
selected. You can select a different resolution. But, an 
alert is displayed if the resolution you select is too high or 
too low in relation to the paper size. Using a higher reso-
lution than required can cause long print times; using a 
resolution that is too low causes “pixelized” (jaggy) out-
put.

• Print Engine — Specify the engine to which the file will be 
printed.

• Output Size — With Constrain Aspect Ratio selected, you 
can type in one dimension and the other dimension will 
change proportionally. Uncheck Constrain Aspect Ratio 
to change the height and width independently. Enter the 
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size in inches, centimeters, percent, or Full Page to fit to 
the paper size selected.

• Copies — Type in the number of copies you want to print.

• Conserve Paper — Only the length of paper needed for 
the print will be fed from the media roll instead of the 
entire length for a standard paper size. When this option 
is selected, Paper Size, Position, and Rotation are 
grayed out. (Not available for color copier output.)

• Paper Size — Select the paper size that will fit your out-
put image area. (Grayed out if Conserve Paper is 
checked.)

• Position — Select the position on the page where you 
want the image printed. (Grayed out if Conserve Paper is 
checked.)

• Rotation — Type in the degree of rotation; select whether 
you want the image rotated clockwise (CW) or counter-
clockwise (CCW). (Grayed out if Conserve Paper is 
checked.)

• Print Options — Lets you set Output Quality, Media Type, 
Interpolation and Sharpening for the selected output 
device. (See the chapter that describes each output 
device for information on these options.)

2. Click Options to set options for the chosen output device.

See the chapter in this manual that describes the output 
device for information on the available options.

3. Click Print to send the file to the RIP.
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Photo CD Notes Downloading a Kodak Photo CD image is similar to downloading 
print files in other formats, with the following exceptions:

• You cannot print a negative of the Photo CD image.

• Photo CD images are available at several resolutions. When 
you select a Photo CD image and image size, the Down-
loader Utility defaults to an appropriate resolution for the 
paper size selected. In most cases, use the default resolu-
tion. The Downloader Utility will notify you if a selected reso-
lution is unnecessarily high for the paper size you select. 

• For efficient RIPing and printing, downloaded Photo CD 
images are always printed in landscape orientation.

• If an image at Photo CD Pro resolution (the highest resolu-
tion) fails to download, try freeing more memory on your 
computer.
3-16 Downloading Photo CD Files



Appendix A

Support Information
• Software DVD-ROM Layout (page A-2)

• Technical Services (page A-3)
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Software DVD-ROM 
Layout

Root Directory
setup.exe - installs the Software RIP

\Documentation

\Drivers
\netcard

\DTC Fonts

\Fonts

\gator-other

\colorspan
\icc

\gatorsi-other

\colorspan
\icc

\Printing Tools

HPIU.exe (Windows)

VideoNet

\Windows 2000
\Windows NT
\Windows XP
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Technical Services For service and support, contact HP Technical Services:

• World Wide Web: www.colorspan.com

• E-mail: cs.support@hp.com

United States and Canada:

• Telephone: (800) 925-0563 or (952) 944-4040

• Fax: (952) 944-8509

Latin America:

• Telephone: +1 (952) 943-3427 or +1 (952) 943-3627

• Fax: +1 (952) 944-8509

Europe/Middle East/Africa:

• Telephone: +31 23.5622000

• Fax: +31 23.5627944

Asia/Pacific:

• Telephone: +1 (952) 943-3320

• Fax: +1 (952) 943-3313
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Appendix B

PostScript Printer Description Files
PostScript printer description files (PPD files) are text files that enable 
software application programs to use the various features of your printer, 
including page sizes, paper handling, font availability, and others. This 
appendix describes the PPD files included on the software disc.
PostScript Printer Description Files B-1



PostScript Printer 
Description Files

The  Printer Description Files (PPDs) describe each  printer to 
the LaserWriter driver. The  software disc contains versions of 
PPDs that are specific to each printer and  RIP type. It also 
includes various alternate version PPDs. The Printing Tools 
Installer automatically copies most of these PPDs to their proper 
locations. Some PPDs must be manually copied to their appro-
priate location.

If you are unsure of how your application uses PPDs, refer to the 
application’s user manual.

Generic PPDs Generic PPDs can be used for Macintosh applications that do 
not require their own specific PPD file format. The Installer cop-
ies the generic Revision 4 PPD files, and Revision 3 PPD and 
PDX files, to the RIP.

QuarkXPress 4 PPDs There are PPDs specifically for QuarkXPress 4, which work 
around a bug in early versions of QuarkXPress version 4.0 that 
resulted in any custom page size printed with a height of 0, 
regardless of the size in the document.

The Installer automatically places these PPDs in the printer-spe-
cific folder within the folder under Macintosh Classic OS ver-
sions. They are not used under Macintosh OS X. (You can also 
copy them from the Printing Tools CD-ROM.) If required, copy it 
to the System : Extensions : Printer Descriptions folder. Then 
select the PPD using the QuarkXPress PPD Manager. Refer to 
the QuarkXPress user manual for instructions.

Alternate Custom Page
Size PPDs

Alternate Custom Page PPDs are used under Macintosh Classic 
OS versions. They are not used under Macintosh OS X. They 
are provided for any printer that supports custom page sizes. 
Some software application programs disagree on the meaning of 
the “Orientation” flag associated with the PostScript custom 
page operator. The symptom is that the image will be output 
rotated, and probably cropped, relative to the page. If this hap-
pens, use the Alternate PPD. 

Revision 4 PPDs Revision 4 PPDs are files that conform to version 4.1 of the 
Adobe PostScript Printer Description File Format Specification. 
They are used by the LaserWriter 8 driver on the Macintosh.
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File naming convention for Macintosh Revision 4 PPDs:

Printer Model Codes
The PPDs are in folders by printer model. This table shows the 
folder codes and printer model codes used in the PPD file 
names.

Folder 
Code Printer Model Code Description

a7 FJ XII/72 DisplayMaker® FabriJet 72"
d4 DM 4000 DisplayMaker HiRes 8-Color 42"
d5 DM 5000 DisplayMaker HiRes 8-Color 52"
d6 DM 6000 DisplayMaker HiRes 8-Color 62"
d7 DM 7000 DisplayMaker HiRes 8-Color 72"
cc ColorCopier Color Copier
dm DisplayMaker DisplayMaker Pro
dme DM Express DisplayMaker Express
dmx DM XL 60 DisplayMaker XL-60
dw DesignWinder DesignWinder
e62 DM Esprit/62 DisplayMaker Esprit 62"
esp DM Esprit DisplayMaker Esprit 42"
gpm Giclee PMFA Giclée PrintMakerFA
gs4 Mach 12/42 DisplayMaker Mach 12 42"
gs6 Mach 12/60 DisplayMaker Mach 12 60"
gs7 Mach 12/72 DisplayMaker Mach 12 72"
kc6 X-12/62 DisplayMaker X-12 62"
kc7 X-12/72 DisplayMaker X-12 72"
pm PM FS PressMate-FS

x5 DM XII/52 DisplayMaker Series XII 52"
x6 DM XII/62 DisplayMaker Series XII 62"
x7 DM XII/72 DisplayMaker Series XII 72"

Special Version

Printer Model

Units Version

RIP Version

[printer] [us|metric] [CMRIP] [Alt|Q4]
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RIP Version
PPDs for RIPStation users contain a smaller resident font list 
than for printers connected to a ColorMark Pro print server. 
These PPDs are identified by “CMRIP” in the position shown.

Metric Code
If the PPD contains metric paper sizes, “Metric” appears in the 
position shown. If the PPD contains U.S. paper sizes, “US” 
appears in the position shown.

Revision 3 PPDs These PPDs conform to version 3.0 of the Adobe PostScript 
Printer Description File Format Specification. The Printing Tools 
CD-ROM includes one set of Rev 3 PPDs to support PageMaker 
and FreeHand and another “generic” set to support all other 
applications that use Rev 3 PPDs. The PPDs for PageMaker 
and FreeHand are identical to the other Rev 3 PPDs except that 
the parameters in the *ImageableArea and *PaperDimension 
keywords are swapped for transverse page sizes (except for B5 
transverse).

Application-Specific
PPDs

Application-specific PPDs are provided for older versions of applica-
tions. Installer copies specific PPD and PDX files into the folder, or to 
the location required by the application. If required, copy them to 
the correct locations (according to the application’s user man-
ual). The Macintosh Printing Tools includes the following files:

• PPD and PDX files for PageMaker and FreeHand — older 
versions of PageMaker and FreeHand use PDX (Printer 
Description Extensions) that contain information required by 
the applications that was not included in the Rev 3 specifica-
tion.

• PosterWorks Settings file

• QuarkXPress PDF files — see below.
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PDFs are files created for use with QuarkXPress. They are 
required for QuarkXPress versions 3.2 and earlier and can also 
be used with versions 3.3 and 3.31. Quark provides a tool that 
helps in the creation of PDFs called MakePDF. PDFs were origi-
nally called XPDs. PDFs are binary files with the data stored in 
the resource fork. 

There are two types of PDF files: one containing fixed paper 
sizes and one that allows creation of variable (custom) page 
sizes. Some engines have both, some just the former. For 
PressMate-FS, these also came in the color and black-and-white 
versions.

QuarkXPress PDFs are included on the Software DVD-ROM, 
but they are not installed by the installer. The last PDFs distrib-
uted by were for the Giclée PrintMakerFA.
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